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Experiment 12 

Gas Laws 

Pre-Lab Assignment 

Before coming to lab: 

• Read the lab thoroughly. 
• Answer the pre-lab questions that appear at the end of this lab exercise. 

Purpose 

Boyle’s Law and Gay-Lussac’s Law will be experimentally confirmed by preparing graphs and 
observing the relationship between the data. A new gas law relating the pressure and amount 
will be determined graphically. 

Background 

In the 17th century, physicist Robert Boyle first published what became as Boyle’s Law, stating 
that for a fixed amount of gas at a constant temperature, the product of pressure and volume is 
constant. This means that the pressure and volume of a gas are inversely proportional. This can 
be restated to calculate changes to the pressure or volume of a gas, as seen in Eqn. 1. 

    PV = constant or P1V1 = P2V2   Eqn. 1 

In the early 1800s, Amedeo Avogadro hypothesized that for ideal gases, when the pressure and 
temperature were held constant then the volume and amount in moles would be directly related. 
This law is seen in Eqn. 3. 

   
V
n

 = constant or V1

n1
 = V2

n2
 or V1n2= V2n1    Eqn. 2 

 

Example Problem: Using Boyle’s Law 

A sample of gas is held at constant amount and temperature at 561 mmHg occupies 0.50 L. 
Calculate the new volume, in L, if the pressure is increased to 0.98 atm. 

Step 1: Convert pressure into the same unit. 

 0.98 atm × 760 mmHg
1 atm

 = 740 mmHg 

Step 2: Use Eqn. 1 to find V2. 

 (561 mmHg)(0.50 L)=(740 mmHg)(V2) 

 
(561 mmHg)(0.50 L)

740 mmHg
 = V2 = 0.38 L 
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In the early 1800s, Joseph Louis Gay-Lussac stated that when the amount and volume of a gas 
were held constant, the pressure and temperature were directly proportional. This law can be 
stated mathematically two ways, as seen in Eqn. 2. 

    
P
T

 = constant or P1

T1
 = P2

T2 
 or P1T2 = P2T1   Eqn. 3 

Kinetic Molecular Theory states that the average energy of molecules in the gas phase is directly 
proportional to the gas’s absolute temperature. The pressure a gas exerts is due to the collisions 
of its molecules with the sides of the container. Therefore, if a gas’s kinetic energy approaches 
zero, its temperature and pressure must also approach zero. 

  

Example Problem: Using Gay-Lussac’s Law 

A sample of gas held at a constant amount and volume exerts 625 torr at 31.0°C. Calculate 
the temperature, in K, when the pressure reduces to 595 torr. 

Step 1: Convert all temperatures to Kelvin. 

 31.0°C + 273.15 = 304.2 K 

Step 2: Use Eqn. 2 to find T2.  

 
625 torr
304.2 K

 = 595 torr
T2

 

 T2= (595 torr)(304.2 K)
625 torr

 = 2.90×102 K 

Example Problem: Using Avogadro’s Law 

A 0.110 mol sample of gas is measured to have a volume of 235 mL. Calculate the new 
volume, in mL, if 0.250 mols is added to it. 

Step 1: Find the new amount (n2). 

 n2= 0.110 mols + 0.250 mols = 0.360 mols 

Step 2: Use Eqn. 2 to find T2.  

 
235 mL

0.110 mols
 = P2

0.360 mols
 

 P2= (235 mL)(0.360 mols)
0.110 mols

 = 769 mL 
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Procedure 

Part I: Boyle’s Law 

1. Obtain a pressure sensor kit.  

2. Connect the pressure sensor to the LabQuest 2. Do not connect the syringe yet. When 
connected, the screen should automatically show the current pressure from the sensor in kPa. 

3. Tap Sensors, then Data Collection. Change the Mode to “Events with Entry” from the drop-
down menu. In the Name box, enter “Volume” and in Units, “mL”. Tap OK. Click the Graph 
tab. The graph should be updated to Volume (mL) versus Pressure (kPa) (Fig. 2). 

 

Fig. 2: Settings and Graph for Boyle’s Law 

4. Using the plastic syringe included in the pressure sensor kit, move the piston until the syringe 
reads 20.0 mL. Hold it in place while screwing the syringe onto the fitting on the pressure 
sensor (Fig. 3). 

1.  
2. Fig. 3: Pressure sensor set-up 

 

5. Press the Green Triangle (Start) in the bottom left-hand corner. The sensor will not record 
any data until the Keep button is pressed.  

6. Press Keep. A pop-up window will appear. Enter the volume from the syringe.  
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7. Carefully move the syringe’s piston up to the 18 mL mark. Hold it in place and press Keep. 
Enter the new volume of the syringe in the pop up window. 

8. Repeat Step 7 for 2 mL intervals (16, 14, 12, etc.) until at least 10.0 mL or further if you are 
able. When it becomes too difficult to depress the syringe further, press the Red Square (Stop) 
in the bottom left-hand corner.  

9. Tap the Table tab (X|Y, third from the right). Tap Table, then New Calculated Column… In 
Name, type “1/Volume”. Under Equation Type, select A/X. Under Column for X, select Volume, 
and in the box next to A: type “1”. Tap OK.  

 

Fig. 4: Calculated Column 

10. Print both graphs. Go to File > Print > Graph. Check the box for grayscale printing. 

 

 

Part II: Pressure and Amount 

1. Use the same set-up as in Part I, including the pressure sensor, interface, and syringe. 

2. Gather a clean, dry 125 mL Erlenmeyer flask. The rubber stopper and tubing provided in the 
pressure sensor bag should fit this flask. Unscrew the syringe from the sensor and attach the 
tubing to the pressure sensor. Make sure that the valve in the stopper’s other hole is closed 
(horizontal). 

3. Tap File, then New. Discard the previous data.  

4. Tap Sensors, then Data Collection. Change the Mode to Events with Entry. In the Name box, 
enter “Amount” and in Units, “Puffs”. Tap OK. Click the Graph tab. 

5. Press the Green Triangle (Start) button in the bottom left-hand corner. Press Keep. A pop-up 
window will appear. Enter “0” puffs. 
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6. Draw air through the syringe to the 3 mL mark. Screw the syringe onto the closed valve on 
the rubber stopper. Open the valve (vertical), and push air the air from the syringe into the 
flask. Close the valve. 

7. Press Keep. A pop-up window will appear. Enter “1” puff. 

8. Repeat Steps 6-7 for a total of five puffs. 

9. Tap the Red Square (Stop) button in the bottom left-hand corner. 

10. Print your graph. From it, determine whether pressure and amount are directly or inversely 
related and write your own gas law. 

 

 

Part III: Gay-Lussac’s Law 

1. Use the same set-up as in Part II. You will not need the syringe. 

2. Collect a temperature sensor. Turn on the temperature sensor by holding down the green 
button until the red light flashes. You do not need its USB cord. 

3. Tap File, then New. Discard the previous data. 

4. Tap Sensors, then Wireless Device Setup, then Go Direct…  The temperature sensors should 
appear as “GDX-TMP”. The number should correspond to the ID above the barcode on the 
back of your temperature sensor. Tap this, then press OK. 

5. Tap Sensors, then Data Collection. Change the data collection mode to “Selected Events” from 
the drop-down menu. Press OK. Select the Graph tab (second from the left) and make sure 
that temperature is on the x-axis and pressure is on the y-axis. 

6. Fill a 600 mL beaker approximately half-full with a mixture of tap water and ice. Set up a 
Bunsen burner, wire gauze, and iron rings. Put the beaker on top of the wire gauze above the 
Bunsen burner. 

7. Gather a dry 125 mL Erlenmeyer flask. Put the rubber stopper connected to the pressure 
sensor tubing firmly in its top. Make sure that the valve on the short tubing is closed. Gently 
lower this into the water bath from Step 4. You will need to clamp the neck in place to 
submerge the flask as far as possible without allowing any water to seep over the edges into 
the flask itself. 

8. Press Start on the LabQuest 2. The sensor will not record any data until the Keep button is 
pressed.  

9. Slide a split stopper over the temperature probe and clamp it inside the water bath about 1 
cm from the bottom. Do not allow the probe to touch the edges of the beaker or Erlenmeyer 
flask. Allow the system about one minute to come to thermal equilibrium before pressing 
Keep. 
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10. Carefully remove the water bath and dump out the ice. Refill it with room-temperature tap 
water and replace it. The temperature should be approximately 20°C. Press Keep.  

11. Turn on the Bunsen burner and heat the water until it is approximately 40 °C. Turn off the 
burner and allow the system approximately one minute to reach equilibrium. Press Keep. 

12. Repeat Step 11 twice more: at approximately 60 and 80°C. Do not allow the water to boil. 
You should have a total of five total data pairs. 

13. Press Stop.  

14. Tap the Table tab. Tap Table, then New Calculated Column… In Name, type “Temperature” 
and in Units, type “K”. Under Equation Type, select X+A. Under Column for X, select 
Temperature and type in A: 273.15.  Press OK. 

 

 
Fig. 5: Calculated Column 

 

15. Make sure your graph shows Pressure on the y-axis and Temperature (K) on the x-axis. Go 
to Analyze, Curve Fit, and select the correct graph. Under Fit Equation, select Linear. Record 
the values for m (slope) and b (y-intercept) in the form of y = mx + b on your data sheet. 

16. Print your graph. 
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Experiment 12—Data Sheet 

Name: ________________________________________ 

Partner: _______________________________________ 

Part I: Boyle’s Law 

Attach both graphs of Pressure versus Volume and Pressure versus 1/Volume. 

Sketch your graphs in the space below. Label the axes, including units. 

 

 

 

 

 

 

Part II: Pressure and Amount 

Attach the graph of Pressure versus Amount 

Sketch your graph in the space below. Label the axes, including units. 

 

 

 

 

 

Are pressure and amount directly or inversely related? Use your observations to explain your 
answer. 

 

 

 

Write the gas law equation for pressure and amount: 
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Part III: Gay-Lussac’s Law 

Attach the graph of Temperature (K) versus Pressure. 

Trendline Equation: ___________________________________________________________ 

Sketch your graph in the space below. Label the axes, including units. 

  



12-9 
 

Experiment 12—Post-Lab Assignment 

Name: ________________________________________ 

For all calculations, show all work and draw a box around the final answers. 

Part I: Boyle’s Law 

1. From your graphs from Part I, is the relationship between pressure and volume of a gas 
directly or inversely proportional? Does this agree with Boyle’s Law? Explain. 

 

 

 

 

 

2. Explain why one of your graphs from Part I is linear while the other is curved. 

 

 

 

 

 

3. From Part I, what is the slope of the line in your graph of 1/Volume versus Pressure? (Hint: 
this is not a numerical value. Define it in terms of the variables of the Ideal Gas Law, PV = 
nRT). 
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4. Give two experimental errors or limitations in Part I and decide if they would change (higher, 
no change, lower) the recorded pressure and volume from their true values. 

 

 

 

 

 

5. A syringe at STP has a total volume of 25.0 mL. If the syringe is depressed to a volume of 
18.5 mL, what will the new pressure be inside the syringe, in atm? 

 

 

 

 

 

 

Part II: Pressure and Amount 

6. Give two experimental errors or limitations in Part II and decide if they would change (higher, 
no change, lower) the recorded pressure and amount from their true values. 

 

 

 

 

 

7. A 0.118 g sample of Cl2(g) has a volume of 115 mL. To this, 0.250 grams of Cl2(g) is added 
at the same temperature and pressure. Calculate the new volume of the gas, in mL. 

 

 

 

 



12-11 
 

Part III: Gay-Lussac’s Law 

8. From your graph in Part III, is the relationship between pressure and temperature of a gas 
directly or inversely proportional? Does this agree with Gay-Lussac’s Law? Explain. 

 

 

 

 

9. Using the trendline equation from your graph in Part III, calculate at what temperature, in 
Kelvin, the pressure inside the flask will be 0 kPa.  

 

 

 

 

 

 

10. What is the theoretical temperature at which pressure inside the flask should equal 0 kPa? 

 

 

 

 

11. Give two experimental errors or limitations in Part II and decide what effect (too high, too 
low, no effect) they would have on the recorded pressure and temperature values. 
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12. If a gas held at 1.2 atm at 25°C is heated to 52°C, what will the new pressure of the gas be, 
in atm? 
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Experiment 12—Pre-Lab Assignment 

Name: ________________________________________ 

For all calculations, show all work and draw a box around the final answers. 

1. What is the relationship between the pressure and volume of a gas? Circle one option. 
 

Directly  Proportional    or    Inversely Proportional 
 

2. What is the relationship between the pressure and amount of a gas? Circle one option. 
 

Directly  Proportional    or    Inversely Proportional 
 

3. What is the relationship between the pressure and temperature of a gas? Circle one option. 
 

Directly  Proportional    or    Inversely Proportional 
 

4. A 2.50 L flask containing N2(g) at a pressure of 0.63 atm is directly connected to an empty 
1.25 L flask with the valve initially closed. When the valve is opened, the gas expands to fill 
both flasks. Calculate the new pressure of the gas, in atm. 
 
 
 
 
 
 
 
 
 
 
 

5. A sample of He(g) is kept in a container with a fixed volume at 23.8°C and at 0.971 atm. If 
the pressure of the gas is decreased to 0.828 atm, will its temperature increase or decrease? 
Calculate the new temperature of the gas in °C at this pressure. 
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